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WORDPROCESSORS 

1.0 INTRODUCTION 
Word processors are the software that transform a computer screen into sheets 

of papers to be electronically written on. A word processor provides a quick and easy 
way to create and revise documents. These screen-based systems enable a user to 
create, edit and print letters, memos, manuscripts, and reports faster and more 
accurately than with a typewriter. These software make the processing of text more 
effective and efficient. For letters and reports prepared in multiple drafts, the ability to 
electronically 'cut and paste eliminates the need for retyping the complete document. 
In addition, documents can be stored in files and retrieved as needed. For mass 
mailing, form letters can be merged with names from mailing lists to personalize 
correspondence. Typically, these packages have the following capabilities: 

Text can be easily written onto an electronic document. 
Any part of the document, whether a letter, word, sentence, paragraph, page, 
or group of pages, can be easily changed or moved elsewhere in the same or 
another document. 
A document's format, such as margins, spacing, page numbers, and headings 
can be set automatically and easily adjusted. 
The document can be created in the desired font and a document can have 
more than one font. 
Text formatting capabilities enable a user to easily specify and modify the 
manner in which text is to be presented. Common formatting actions include tab 
setting to indent lines and columns, paragraph justification to obtain fixed 
paragraph borders, and text highlighting, such as bold, underline, italics etc. 
Graphical images can be created as a part of the document. Also, graphic 
images created by other software can be imported in the document. 
Most word processors have capability to handle footnotes, page headers and 
footers, superscripts, and subscripts, and to automatically produce a table of 
contents or an index. 
Some word processors are capable of spreadsheet functions and mathematical 
operations. 
Spell .  checkers make use of online dictionaries to locate spelling errors. 
Thesaurus support provides an online thesaurus. Style checkers analyze a 
document to locate and correct grammar or punctuation errors and suggest 
ways of improving writing style. 
Mail-merge programs link the document with address list to "mass mail" letters. 
A partially completed document can be stored on a floppy or hard disk to be 
retrieved later for completion. Once completed, a document can be stored on 
a floppy or hard disk and then retrieved later for printing or revisions. 
The complete document, or just a portion of it, can be retrieved from secondary 
storage and inserted anywhere in another document. 

The main advantage of a word processor is that the matter once entered in the 
computer can be used in more than one document, and can be easily updated. 
Moreover, after minor changes, the entire document need not be re-checked again. 
Also a report can be quickly condensed to prepare a paper and the paper can be 



quickly edited to prepare transparencies for presentation. The documents prepared at 
one branch of an office can be (electronically) communicated to other branch where 
it can be suitably edited and printed. 

Mathematical equations are an integral part of a scientific paper or report. 
These equations can be easily written using equation handling capabilities of a word 
processor. 

Some popular word processing software include WordStar, WordPerfect, MS 
Word and ChiWriter. The present discussion describes some details of the 
WordPerfect. For further details, one may refer to the reference manual of the 
software. 

2.0 WORDPERFECT 
The WordPerfect is a popular word processing software developed by 

WordPerfect Corporation. Some of the commands and feature of version 6.0 for DOS 
are described below. When the system is invoked, the welcome screen appears on 
the monitor for a few moments after which, a new document window is opened. This 
window can be thought of as a new sheet of paper where margins, spacing and tabs 
have been set according to the default settings. The bottommost line is the Status 
Line which shows the name of the document, if any, and the document number, page, 
vertical and horizontal position of the cursor in the document. The Menu Bar shows 
various commands which can be invoked by pressing Alt key and the underlined 
letter. The desired function can be carried out either by the menu commands or 
through shortcut keys. In some instances, a dialogue box is opened after pressing 
command keys. The box is used to pass additional information to the WordPerfect to 
execute that command. To return to the document without executing a command, one 
can press the Esc key on keyboard or Cancel feature in the dialogue box. If a mouse 
has been installed, then by clicking the pointer on a particular item, the corresponding 
menu is opened. For explaining various first hand facilities of the WordPerfect, the 
different menus are briefly discussed in the following. 

2.1 FILE Menu 
The File menu is evoked by pressing the A/tand Fkeys together and it opens 

a dialogue box. Using this menu, the user can Open a new document, can Save a 
document, can call the File-Manager to display a list of files, can customize the Set 
Up, can Print a document or Exit from WordPerfect. The File-Manager can also do 
various other file management options such as Copying, Printing, Deleting or Moving 
a document. 

The document to be opened need not necessarily be a WordPerfect document. 
The WordPerfect automatically identifies the format of the input document and can 
Convert from various input formats to the WordPerfect format. A user can also convert 
WordPerfect files into other formats. Note that while converting a file, it may not be 
possible to correctly convert some symbols, equations or tables etc. 

This menu has a Master Document feature also. A master document is a 
WordPerfect document like other documents except that it also contains codes linking 
it to other documents. When a master document is expanded, those other 



subdocuments are retrieved into the master document. Master document feature is 
used to manage large document instead of maintaining one large file. It is easy to 
create several subdocuments and one master document. Compare Document feature 
is used to contrast the text in the current document with the text in a different version 
of the document. WordPerfect indicates deleted text with strikeout text while added 
text is represented by redlined text. Moved text is indicated by two messages. 

WordPerfect can automatically make a backup copy of the current document 
to protect losing work because of power or equipment failure. The user can specify 
time interval for timed backup or turn off Timed Document Backup with the help of 
Environment option in the Setup feature. The Backup, Beep Language, Hyphenation 
etc. options can also be changed by the Environment dialogue box. The change in the 
Environment dialogue box remains in effect until the user changes them again. 

It is necessary to select and install a printer to print from WordPerfect. Choose 
the Print feature from the menu. The print dialogue box opens and the print range and 
the number of copies can be chosen. The matter to be printed can also be previewed 
before it is sent for printing. The matter is displayed on the screen exactly as it will be 
printed and this usually saves time and avoids wasteful printing. The printing matter 
can also be controlled after sending to the printer with the help of Control Print option. 
The control print dialogue box displays the print queue of all the print jobs which have 
been sent to the printer. A print job can be cancelled with the help of Cancel Job 
option. 

2.2 EDIT Menu 
The Edit menu is evoked by pressing the A/tand Ekeys together and it opens 

a dialogue box. Using this menu, the user can perform various Block operations, can 
Undo the changes or Undelete a set deleted by mistake, can perform Search and 
Replace operations and can Go To desired location in the document. 

A Block can be selected by pressing the Alt and F4 keys and then by the 
arrow keys. Various block options include Cut, Paste, Copy Case change, Appending 
to a file etc. Blocks can be selected in the column mode also. 

By pressing the Ctrl and Home keys together, a dialog box appears and then 
by entering the page number, the cursor moves to the desired page number of the 
document. 

The user can Search and Replace word, phrase or codes in the document. To 
search word & codes, the cursor is placed at a place from where the user wants to 
begin. Press F2and then type the text and select any of the desired options from the 
search dialogue box. Next choose Search option to begin the search. Similarly, Alt F2 
keys open the Search and Replace dialog box using which replacement for a particular 
search can be made. 

This menu also provides Bookmark features that are used to mark a location 
in the document so as to return to that location quickly. A document can have several 
bookmarks, with each bookmark with a unique name. 



Using Undo, last editing actions like deleting a word or sorting, changing font, 
changing margins etc. can be reversed. Undo feature slow WordPerfect operations 
and consumes memory and disk space. To avoid this, Undo can be turned off. Using 

the Undelete feature of this menu, any or all of the last three deletions can be 
restored. Unlike Undelete, which restores most recently deleted text at the cursor, 
Undo restores text in its original location. 

2.3 VIEW Menu 
The View menu is evoked by pressing the A/tand Vkeys together and it opens 

a dialogue box. Using this menu, the user can set various viewing options. These 
include selecting Display Mode, Button Bar, Outline Bar, Scroll Bar, Pull-Down 

Menus and the Ribbon etc. In addition, the Screen Setup and the Reveal Code 

window set up can be defined. 

Three display modes are available in WordPerfect: Text mode, Graphic Mode 

and Page mode. The user can switch between display modes during editing of any 
document. Text mode display the document in monospaced characters, like the screen 
characters. In text mode, the contents of graphics and equation boxes are not 
displayed on screen and user cannot use the mouse to size and move graphics. The 
graphic mode displays the document close to the way it will look when it prints. Page 
mode displays the characters in the document like Graphic Mode. However, while 
Graphic Mode shows only the body of the document, Page Mode displays such things 
as document headers, footers, foot notes and label arrangement. 

Reveal Codes are used to view the formatting codes in the document. A code 
is inserted in the document nearly every time a WordPerfect feature is used. Codes 
are not visible in the normal document window. Since the placement of most codes 
is essential, it is sometimes needed to observe their exact location. Reveal Codes 
divides the document window in two parts. The top part is the normal editing area 
while the lower part displays the same text accompanied by codes. 

The user can use Ribbon feature to quickly access a variety of features that 
affect the size and appearance of text in the document. The ribbon can be accessed 
only with a mouse. Any setting which is done by Ribbon is in effect for the current 
document only. With the help of this option it is easy to change Display Size, 
Paragraph Style, Number of Columns, Alignment Font Type as well as Point Size in 

a text. 

Outline bar is used to organize text using numbers, bullets, or headings. The 
items on the Pull-Down Menus perform different kinds of action. A menu item followed 
by three dots (...) opens a dialog box, followed by a triangle ( ) opens another menu 
while an item followed by no marking starts the feature. 

Use of Button Bar gives quick access to frequently used menu items, features, 
macros and other Button Bars. Seven button bars can be selected or created from this 
menu. A mouse is necessary for choosing the buttons. In the Graphics and Page 
modes, Zoom can be used to specify the size of on-screen text. Zoom percentage can 
be specified using this option. Scroll Bars are used to move the cursor to different 
parts of the document window or to move through a list of items in a dialog box. 



Screen Setup is used to change the on-screen Appearance of Menus, 
Windows, and Codes and to specify the Default Zoom Percentage. The changes made 
in the Screen Setup dialog box remain in effect until they are changed again. The Pull-
Down Menus, Outline Bar, Ribbon, and Button Bar can be turned on and off. Hard 
Return Display characters can be specified and various Window Options, Reveal 
Codes Options and Zoom Options can be defined using Screen Setup. 

2.4 LAYOUT Menu 
The Layout menu is evoked by pressing the Alt and L keys together and it 

opens a dialogue box. Using this menu, the user can set various layout options. These 
include selecting formats for Character, Line, Page and Document. In addition, it can 
generate Tables and Columns, can specify Margins, Justification, Tab settings and 
Alignment, and can set Footnotes, Endnotes and Comments etc. 

The Character format include Decimal Character, Thousands Separator, Dot 
Leader Character etc. The Line format include specifying Tab Settings, Justification, 
Line Spacing, Line Numbering, Line Height etc. The Page format includes specifying 
Page Numbering, Page Centering, Page Sizing Double Side Printing Page Bordering 
and Suppressing etc. 

Using Columns, the text can be vertically divided on a page. As many as 24 
columns can be specified. Tables can be used to organize information into columns 
and rows without using tab setting. The user can also create spreadsheets by the 
Table command. In WordPerfect, the user can insert formulas & functions into table 
directly by the use of Table Formula dialogue box. 

Envelop feature is used to create an envelop using the mailing address in the 
document or by specifying the return and mailing addresses. Merge facility is used to 
generate multiple envelops from a list of addresses. 

A document margin is the white space between the text and the edge of a 
printed page. Using the Margin feature, it is possible to change the Left, Right, Top 
and Bottom Margins. The default margin settings are 111  on all sides. Using 
Justification, it is possible to align the text on the right or left margins, along both 
margins, or to center it between the margins. Tabs move the text an exact amount of 
space. Tabs, rather than spaces, are used to align columns of information. WP 
contains four types of Tabs (Left, Right, Center and Decimal). Tab settings display as 
triangles on the bar at the top of Reveal Codes. The Alignment option contains 
features like Centering a line, Rush Right to align a line with the right margin, forced 
closing of a page by Hard Page etc. 

Headers and Footers are used to print information such as a chapter title, a 
date, a person's name, or a company name at the top or bottom of each page or on 
alternate pages. Two different headers and footers can also be used. Headers print 
just below the top margin while footers print just above the bottom margin. A header 
or footer appears on the specified pages (all pages, odd pages, or even pages). A 
Watermark is used to add a drawing, logo, clip art image, or headline sized text 
behind the printed document text. Water marks function similarly to Headers and 
Footers. Two water marks can also be used at any place in the document. 



Footnotes and Endnotes are used to list sources or provide detailed 
information about items in the text. Footnotes are printed at the bottom of a page while 
Endnotes are usually printed at the end of a document. Comments are used to add 
comments to the text. Comments appear on the screen but are not printed as part of 
the document. Comments are used to note scheduling changes to make, to record 
upcoming announcements, or to store information. The Comments feature can also 
be used to pool comments or suggestions from several people who are reviewing or 
editing the same document. 

2.5 TOOLS Menu 
The Tools menu is evoked by pressing the A/tand Tkeys together and it opens 

a dialogue box. This menu contains Writing Tools, Macro, Merge and Sort facilities. 
In addition, it can generate Index, Table of Contents, Cross-references and Table 
of Authorities etc. Maths and Spreadsheet functions can also be performed. 

Writing Tools contains various options: Speller, Thesaurus, Grammatik and 
Document Information. The Speller checks the document for misspelled words, 
duplicate words, and certain type of capitalization errors. When the speller finds a 
misspelled word, it is highlighted in the text of the document and various options are 
suggested. The user can select any of these options to replace the misspelled word, 
or can skip/edit the word, or can add the word to a personal dictionary. Thesaurus is 
used to search for synonyms or antonyms of words. Gramma is used to check the 
documents for spelling, grammar, and punctuation errors. Using the Document 
Information, statistics regarding characters, words, lines, sentences, paragraphs and 
pages in the document can be quickly acquired. It also displays information about 
word length, words per sentence and the size of the document. 

Macros are used to record commands that perform a task automatically. The 
macro language is a command-based language. The WordPerfect macro languages 
also include programming commands and operators such as AND, OR, LABEL & 
CHAR. Outline is used to organize text using numbers, bullets, or headings. Merge 
feature is used to merge mass product, letters, envelops, mailing labels, contracts, 
phone lists, memos or other documents. With the help of this utility we can write the 
same letter to a number of persons without typing the original letter more than once. 
To do so, two files are created one of them is a form file containing form letter and 
another is data file containing names and addresses of the person. Then the two files 
are merged to create a third file, which contains all the merged letters, or the new 
document can be directly sent to the printer. Sort feature is used for arranging text 
alphabetically or numerically or to extract specific information from a list. The user can 
sort paragraphs, table rows, parallel columns or merge data file records. For sorting, 
first open the document containing the information. To sort a table or parallel column, 
the cursor is placed inside the table or parallel column. Date feature is used to place 
the current date and time in the document and to change the date format. A date code 
is updated to reflect the current date each time the document is retrieved or printed. 

Index is used to create and maintain an index for a document. An index can 
include both headings and subheadings. Creating an index involves three steps: 
marking the text to be included in index, defining the output and then generating the 
index. Table of Contents is used to create and maintain a table of contents for the 



document. It can have upto five levels of heading and subheadings and its creation 
involves the same three steps as mentioned under Index. List is used to create lists 
of items such as figures, illustrations, and tables in a document. Generate is used to 
update table of contents, lists, and indexes in the document. 

In WordPerfect to perform basic math calculations, Math feature is used. Table 
feature is used when the information is divided into cells, rows and columns. Math 
feature is used for calculation of financial statements such as income statements and 
balance sheet. Spreadsheet Import and Link feature is used to copy information from 
a spreadsheet file into a document. Importing a spreadsheet copies information from 
the spreadsheet file. Linking a spreadsheet updates the spreadsheet information in the 
document to keep it current with any changes. 

Hypertext is used to link parts of the current document to other parts of the 
document, to other documents, or to a macro. 

2.6 FONT Menu 
The Font menu is evoked by pressing the A/tand Okeys together and it opens 

a dialogue box. Using this menu, the user can set various font options like selecting 
the Font Type and Size, Subscript and Superscript etc. It also includes features like 
Bold, Underline, Italics, Outline, Shadow, Redline and Strikeout for a portion of the 
text. In addition, special WP Characters can also be inserted. 

The Font is the basic type face in which the document is printed. The font in 
any documents consists of three elements: Type Face (such as Times Roman), 
Appearance (such as Bold or Italic) and Size (such as 10 CPI or 10 Pt). The user can 
see a list of available fonts to select the font in the dialogue box. There are two ways 
to change the font of existing text. The user can insert a font code before the text or 
can block the text and then choose a font. 

In addition to the characters and symbols on the keyboard, WP provides more 
than 1500 international characters and symbols: ASCII, math, scientific, typographical 
symbols etc. that can be inserted anywhere in a document. These are grouped into 
fifteen different types of sets. 

2.7 GRAPHICS Menu 
The Graphics menu is evoked by pressing the Alt and G keys together and it 

opens a dialogue box. Using this menu, the user can Retrieve an Image, can Draw 
Graphics Boxes and Lines, can Draw Lines and Borders etc. 

Graphics is used to import Clip All Images, Logos, Charts, or Drawings into a 
document. It can also add Tables, Quotes, Text Sidebars, or Equations. There are 
two ways to add a graphic to a document. The first method is to create a graphics box 
and then put text, image, a chart, an equation etc. inside the box. The second method 
is to retrieve a clip art image, a chart, or a drawing directly into a document. There are 
eight different graphics box styles with different options. WordPerfect has a number 
of in-built images that can be retrieved using the Retrieve Image feature. 



The WordPerfect has a powerful Equation Editor which can be used to create 
or edit mathematical equations. This editor is versatile enough to create and edit the 
equations and contains the feature like subscript's, superscripts, various symbols, 
matrices etc. The user types the equation using the available commands and can view 
the equation as it appears in the document through a view box. 

Image editor is used for retrieving a bit map image or vector image into a 
graphic box. We can use the image editor to crop, rotate, scale or adjust the color of 
the image and can also change the fill type of a vector image. 

Using Line Draw feature, it is possible to draw simple boxes, graphs, and 
borders. Using the arrow keys, lines can be drawn in any character in an empty space 
or around and over existing text. Using Borders feature, a border can be added 
around a paragraph, page or column. Using the Fill Style feature, the appearance of 
each graphics box can be changed. 

2.8 WINDOW Menu 
The Window menu is evoked by pressing the Alt and Wkeys together and it 

opens a dialogue box. In the WordPerfect, up to nine documents can be opened at 
a time. One can move the text from one document to the other or can switch from one 
window to the other. More than one documents can be viewed at a time by dividing 
the screens in windows. 

An area on the screen is called a document window. The frame is the border 
around the window. A Framed window can be maximized, minimized, dragged or 
closed. To move the window with a frame, drag the title bar at the top of window. 
When more than one window is open, Cascade feature can be used to arrange them. 
Cascaded windows overlap so that the title bar of each window is displayed. If more 
than one window is required to be displayed, Tile feature can be used to arrange the 
windows. Tile windows are arranged with no overlapping. It is possible to switch 
between displayed or undisplayed windows by clicking the mouse. 

2.9 HELP Menu 
A comprehensive on-line help is available for the various WordPerfect 

commands. The help can be obtained by pressing the Fl key or using the menu 
command Help. The Help menu has several features like Contents, Index, How Do 
I, Coaches, Macros, Tutorials, and WP Information. 

To get the basic information about word processing, Tutorial feature of Help 
menu is used. Using the Contents option, a list of often-used Help categories can be 
obtained. Coaches is an interactive tutorial that can guide through simple and complex 
tasks. 


	00000001
	00000002
	00000003
	00000004
	00000005
	00000006
	00000007
	00000008
	00000009

